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JIS-Link Customer Manual 
 
AOC shall not be responsible for providing support or assistance of any nature to you or any 
third party acting on your behalf.  The Administrative Office of the Courts has made 
available for use by the JIS-Link customer the BlueZone Software to access the JIS 
Application. This manual is the only method of support available to JIS-Link Customers. 
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JIS APPLICATIONS 
 

JIS - District and Municipal Court Information System 
 
Overview 
The JIS application (formerly called DISCIS but was renamed to JIS several years ago) 
contains case information from district, municipal, and superior courts. If you are looking for 
district and municipal court information, always search the JIS application.  If you are 
looking for superior court information, however, you may find more of the information you 
need in SCOMIS.  The JIS application contains only limited superior court information. 

 
Use the JIS Application for statewide searches for persons with felony, gross 
misdemeanor, misdemeanor, infraction, domestic violence, harassment, and certain family 
related cases that include IN type persons.  [Examples of family related cases that involve 
IN (individual) type persons include child custody and dissolutions with children.] For all 
these types of cases use the State Name Case Index (SNCI) command to search statewide 
or the Civil Name Case Index (CNCI) command to search within a specific court. 

 
Also use the JIS Application to search for district and municipal court civil and small claims 
cases. Civil cases include vehicle impounds, name changes, lien foreclosures, and property 
damages. The major participants in these cases are CV (civil) type persons. Civil Person 
records are NOT statewide but are court specific. Use the CNCI command to search for 
these cases on a court-by-court basis. 

 
Superior courts began entering criminal data in the JIS Application using a staggered 
approach from 1994 through 1995. The accuracy of the data goes back to 1997. Prior to 
1997 the data may or may not be in JIS. 

 
You need to be aware that mainly criminal cases from the superior courts are entered in the 
JIS Application. There may be some case type 2 cases that for money reasons or due to 
the filing of anti-harassment orders will show up. 

 
In district and municipal court certain case types are eligible for archiving to off line storage 
two years after the disposition date.  An archived case can only be restored by the court. 
You may contact the courts directly for further information regarding the archiving and 
destruction of records. 

 
JIS is made up of three separate systems: Non-Civil Cases, Civil Cases, and JASS 
(Judicial Accounting Sub System). 

 
NON-CIVIL CASES 

 
Non-civil cases are based on a statewide person-centered system. Persons are added to 
the JIS and then cases are linked to the person record.  To access a non-civil case, you 
must know either the case number or the name of a person associated with the case. Non- 
civil cases include criminal, DUI, infraction, domestic violence, and anti-harassment cases. 
Non-civil cases in the district and municipal courts have a unique person name code type of 
IN. 
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CIVIL CASES 
 
District and municipal court civil cases are based on a court-specific system (they are Not 
filed statewide). Civil parties are added to civil cases within a court. Civil parties are not 
shared statewide by other JIS courts. To locate civil cases for a party, you must sign on to a 
specific court and then search for the case in that court. Civil cases include small claims, 
domestic violence, vehicle impounds, name changes, anti-harassment petitions, and lien 
foreclosures. Civil cases in the district and municipal courts have a unique person name 
code type of CV. 

 
JASS (JUDICIAL ACCOUNTING SUB SYSTEM) 

 
This accounting system is used by courts to handle cases and monies associated with a 
case. 

 
Seattle Municipal Court (SMC) Cases 

 
You may see cases for SMC listed on screens for a defendant in JIS (SMC###). However, 
cases from that particular court are uploaded into JIS as opposed to actually being filed on 
the system. You will merely see a case number and name, but cannot access other typical 
JIS screens for SMC cases. The SMC uploads ONLY CN (criminal non-traffic) and CT 
(criminal traffic) case type information to the AOC--no civil or infraction cases are uploaded. 

 
Usage of BlueZone 6.1 on smart phones and smart pads 

 
Non-Windows-Based Smartphones, Smart Pads, I-Phones, and I-Pads will not work with 
BlueZone at all. 

 
If the Smartphone or the Smart Pad uses Windows 8 as the O/S with Internet Explorer 11 
you can load BlueZone 6.1. Follow the same Installation instructions that begin on page 6 
of this document. 
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Terminal Emulator Software 
JIS-Link customers must log on to the AOC mainframe computer to access JIS applications. 
To do so, they must use emulator software to connect to the AOC mainframe. Emulator 
software is used to interface between a PC and the AOC mainframe server. The AOC 
provides two emulator software options to accommodate customers’ needs: BlueZone 
(Windows-based) and “Access JIS-Link via Browser” (Internet-based). If you wish to load 
Bluezone on a MAC you will need to purchase some type of Windows to MAC Terminal 
Emulator to run Bluezone through as Bluezone is a Windows-based software. 

 
Access JIS-Link 
via BlueZone 
(Recommended) 

 BlueZone includes the ability to view mainframe Help windows. 
 First time use of BlueZone requires a software download prior 

to logging on to JIS. You will need to disable pop-up blocker 
software during installation of BlueZone. 

• BlueZone cannot be used for Macintosh (MAC) Computers 
without using Windows Emulator Software, such as “Microsoft 
Virtual PC for Mac 7.0 with Windows Vista,” as an interface 
between Macintosh O/S and Windows O/S. 

 This is the 1 option at www.courts.wa.gov/jislink page. 

Access JIS-Link 
via Browser 

• No software to download for “Access JIS-Link via Browser”. 
• This is the 3 option at www.courts.wa.gov/jislink page. 

http://www.courts.wa.gov/jislink
http://www.courts.wa.gov/jislink
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Installation Requirements 
BlueZone is designed to work with Internet Explorer 7.0 and newer. These instructions are 
for Internet Explorer only. If you choose to use another web browser other than Internet 
Explorer, you will be responsible for modifying your own security settings. 

 
We have noticed that Windows 7 & 8 PCs with IE 10 or newer can cause the following 
issue: 

 
IE10 and IE11 seem to not recognize Active X thus tries to deploy the JAVA version of 
BlueZone which in turn will display the error that BlueZone needs JAVA loaded. The work 
around is to set wa.gov as a Web Site in the Compatibility View Settings. 

 
1. Open Internet Explorer. 
2. Select Tools > Compatibility View Settings. 
3. In “Add this website:” type wa.gov 
4. Press Add 
5. Press Close 

 
Note: The following web browsers will not work with BlueZone: 
Google Chrome 
MAC Safari 
Mozilla Firefox 

 
You must have local administrative rights to download. If you do not have these rights, your 
IT staff will need to grant them to you. They can remove the rights once the download is 
complete. 
Minimum O/S is Windows Vista with Service Pack 2 (SP2) 
Enable ActiveX controls for Windows Vista or Windows 7. If ActiveX controls cannot be set 
with your Internet Browser you will need to find one that does allow this or use Z-Web Host. 

o Enable automatic prompting for ActiveX controls. 
o Enable or prompt download signed ActiveX controls. 
o Enable or prompt run ActiveX controls and plug-ins. 
o Enable or prompt script ActiveX controls marked safe for scripting. 

Add http://www.courts.wa.gov to your browser’s trusted sites. 

You may need to turn off anti-virus software. 
Google or Yahoo toolbars sometimes interfere with the download, so you may have to 
disable these toolbars for the install. 
BlueZone is not compatible with Macintosh/Apple PCs unless using Windows Emulator 
Software, such as “Microsoft Virtual PC for Mac 7.0 with Windows Vista or Windows 7,” as 
an interface between Macintosh O/S and Windows O/S. 

http://www.courts.wa.gov/
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Errors 
If you are experiencing problems with BlueZone, you may need to clear the BlueZone 
settings. 

 
To Clear the BlueZone Settings please click on this link for instructions. 

 

If you receive any kind of port error (unable to establish connection w/host or host port is not 
listening), your internet provider may need to open up ports. 
Port 80 - Internet 
Port 23 - Telnet 
Port 23001 – SSL 

 

If you receive error S18 “A valid Software Activation File (SAF) was not found or your 
evaluation period has expired. Please contact your system administrator”, you must follow 
the steps below: 

 
It’s very important that when you clear the BlueZone settings that you also make sure that 
all BlueZone folders are deleted from these locations: 

 
C: \BlueZone 
C:\Program Files\BlueZone 
C:\Users\<User Profile>\My Documents\BlueZone 

 
Also, if you have more than one profile using the machine, make sure everyone is using the 
same version. One person cannot have 5.1 and another have 6.1. 
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Install BlueZone for JIS Link Customers 
 
These instructions were written with the assumption that the customer is using an Internet 
Explorer version that is 9.0 or lower. AOC does not support any other web browsers other 
than Internet Explorer. 

 
 
Check Internet Explorer Settings prior to Installing BlueZone. 

1. Make sure that your Windows Login Profile has Local Administrator Permissions 
while you load the software.  BlueZone is a Profile Specific Software. 

2. Open Internet Explorer. 
3. Select Tools > Pop-up Blocker. 
4. Make sure the Pop-up Blocker is turned off. 
5. If you cannot find it listed in Control Panel, go to www.java.com and download the 

free version.
 3

 

 
 
 
 
 

4 

http://www.java.com/
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6. Select Tools > Internet Options 
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7. Select the Security Tab. 
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8. Uncheck the box “Enable Protected Mode”.  You will need to restart Internet Explorer. 
9. Under  “Select a zone to view or change security settings” select Trusted Sites 
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10. Select the Sites button 
 

10 



Revised August 20, 2018 13  

11. In the “Add this website to the zone” field, type the following address: 
https://www.courts.wa.gov. 

 

  https://www.courts.wa.gov/  

11 

http://www.courts.wa.gov/
http://www.courts.wa.gov/
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12. Click the Add button 

 
 

13. Click Close 
14. Click Apply then OK. 

 

12 

https://www.courts.wa.gov/ 

http://www.courts.wa.gov/
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Open Internet Explorer. 
 

1. At the Address Line type http://www.courts.wa.gov/jislink 
 

2. Under Current Subscribers, select 1.  Access JIS-Link via BlueZone 
 

 
3. Under the desired BlueZone version, select Click Here to start using BlueZone. If 

you are using Internet Explorer 10 or newer you are required to use BlueZone 
version 5.1 or 6.1.  Windows 8 is required to use Bluezone version 6.1 

 

 

 

http://www.courts.wa.gov/jislink
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4. When the screen below comes up, click the RUN button. 
 

 
5. Select “Install 

 
 
 
 
 
 
 

6. Select RUN on the “Internet Explorer – Security Warning” screen. 
 

 

 

This Add-On for All Users on This Computer…” 
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You will see the progress of the install on the “Web to Host Control” screen. 
 

 
7. When the install completes select Run on the “Internet Explorer – Security Warning” 

screen. 
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8. If the Install went well you will see a screen similar to the one below. You will also 
see an icon on your desktop with the name “Access JISLink”. 
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To Clear BlueZone Settings 
 
Reasons why you may need to clear the BlueZone settings. 

A. The icon on your desktop is corrupted, you receive an error when you double click on 
it or nothing happens. 

B. You want to upgrade BlueZone to a newer version. 
C. If you get an Activation Error. 

 
1. Go to our web site www.courts.wa.gov/jislink 
2. On the left side under Current Subscribers click 1. Access JIS Link via 

BlueZone 
3. Under BlueZone <Installed Version> Look for the sentence that states” If you are 

experiencing problems with BlueZone, you may need to clear the BlueZone 
settings.  Click Here to Clear the BlueZone <Installed Version> Settings.” 

4. Click Here to Clear the BlueZone settings 
5. The following pop-up window will display: Internet Explorer –Security Warning 

“Do you want to run this software?” 
 

6. Click Run 
 

7. A pop up window “BlueZone ezClear Utility “, will display: You will be asked, “Are 
you sure you want to clear all BlueZone ….” Each version will have a different 
number of boxes and different verbiage.  Make sure all boxes are checked. 

 
 
 
 
 
 
 
 
 
 
 
 
 

8. Check All available boxes. 
9. Click Yes 

http://www.courts.wa.gov/jislink
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10. Pop-up window Remove Web-to-Host User Data will display. 
 

 
11. Pop-up Window BlueZone Uninstall displays. 

 

 
12. Click OK 
13. Delete the icon Access JISLink from your Desktop (right mouse click the icon then 

left click Delete.  When prompt “Confirm File Delete”, click Yes). 
 

 
14. Reboot PC 

 
15. Make sure BlueZone is completely out of the directories by checking the following 

three places on the C drive. 
 

1. C:\ BlueZone 
2. C:\Program Files\ BlueZone 
3. C:\Users\<user profile>\ BlueZone 

 
If the files are not found, proceed with installing BlueZone. If the files are found, delete 
them, then proceed with installing BlueZone. 
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Connecting to JIS-Link via the Web Browser 
 

The new interface software that connects through the Web Browser allows you to use the 
same commands and Function Keys as Bluezone. You now have the choice of using the 
PF Keys at the bottom of the screen as before or using the same Function Key commands 
as Bluezone uses on your keyboard. 

 
Use the new interface software if you are using a MAC Computer or Laptop, I phone, I 
Pad, Smart Phone or Smart Pad otherwise we recommend you access via BlueZone. 

Connecting to the AOC Mainframe Computer. 
 
 

 
1. Select the 3.  Access JIS-Link via Browser link. 
2. If this is the first time you are connecting to AOC, you may need to accept the 

security certificate when prompted. 
3. Continue with the steps below for Logging on at the AOC Screen. 
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Logging on at the AOC Screen 
 

 
• You now have the option to use the PF Keys at the bottom of the screen or the same 

Function Keys as Bluezone uses on your keyboard. 
• The new interface software is more compatible with PCs that have pop-up blocker 

software and must be used if a MAC Computer, MAC Laptop, I Phone, I Pad, Smart 
Phone or Smart Pad is being used. 

• Mainframe Help windows are not accessible from the new interface software. 
• No software downloads for the new interface software. 

 
4. Search JIS and SCOMIS as instructed in the respective sections of this manual. 
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JIS-LINK First Time Login 
 
1. When you log on for the first time (whether using a new ID or a password that has been 

reset), use the temporary password given to you by the JIS LINK Administrator (in 
UPPERCASE), and press ENTER. (Do not enter anything in new password field until you 
have received the expired message.) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. You will receive a message “Your password has expired.  Please enter a new one.” at 

the bottom left of the screen following the updated (12/12/2013) password standards. At 
that point type a new password in the new password field. NOTE: After typing the 8th 

character the cursor automatically moves to TRANSFER, press <ENTER>. 
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3. Another message will display, “Please re-enter your password for verification.” Type the 
password again in the new password field and press <ENTER>. NOTE: After typing the 
8th character the cursor automatically moves to TRANSFER, press <ENTER>. 

 

Password Standards: 
 

1. AOC requires the use of "hardened passwords", which means passwords MUST 
have the following characteristics: 

2. Passwords must be EXACTLY 8 characters. 
3. Passwords MUST have at least one upper case letter, at least one lower case 

letter, AND at least one number. 
4. Passwords must not contain the user’s login name, or any part of the user’s full 

name. In other words, passwords may not contain any three or more consecutive 
characters from your name as it appears in the RACF database. For example, user 
"John Smith" may not use the consecutive characters "Joh", "John", "Smi", "Smit", or 
"Smith" as part of his password. 

5. ONLY these special characters may be used (although they are not required):  @ # $ ! 
% & * _ + | : ? > < . - =.  If you choose to use a special character in your password, you 
must still include at least one upper case letter. 

6. Passwords will expire every 90 days. 
7. The last 10 passwords used by an individual must be unique. 
8. Passwords are revoked after five (5) incorrect attempts. 

 
You cannot change your password if your account is revoked or you forgot your password. 
Your site coordinator will need to reset your password. After five attempts to log in with an 
incorrect password, the user ID will be revoked. If this happens, you will need to contact 
your Site Coordinator to have your password reset. 
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The Site Coordinator or Alternate Coordinator from your agency should refer to the JIS-Link 
Security/Billing Manual for help. 
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Log into JIS 
 
Type your User ID then tab to Password. After typing the 8th character of your password, 
the cursor automatically moves to New Password.  Just Press <ENTER>. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If after creating your password you get an invalid password error please see the FAQ 
section for your answer. 

 
If after typing the User ID and Password and then Pressing Enter you receive the message 
“Terminals incompatible…to continue enter a valid transfer option: Yes|No|Hold”, type YES 
at TRANSFER and press <ENTER>. This message will appear if you have been logged on 
to another PC in your office. 
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To Maneuver in the JIS Application - (F4) 
 
The below screen shots and keystrokes are for 1. Accessing JIS-Link via BlueZone. Not 
the web to host, 3.  Access JIS Link. 

 
You should use the Tab key to move to a field.  If you point and click and are not in the 
exact position in the field and you begin to type, you will lock up (bottom left of your screen 
will be an ‘X Not Here’ and a red circle with a line). To unlock press the <Esc>. key then the 
Home key and Tab to the field. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

F1 - Help Screen. Place your cursor on ‘certain’ words and press F1 and it will tell you the 
meaning. 

F2 - Clears the screen in JIS if you are at the JIS Main Menu (MAM) 
F3 - will close the help screen or changes the court name back to *SW if you are at the JIS 

Main Menu (MAM) 
F7 - Page Back 
F8 - Page Forward 
F12 - Takes you back a screen (Back to the JIS Main Menu (MAM)) 
Page Up - Key Takes you back to the JIS Main Menu (MAM) 
Page Down - Key toggles between applications. If you have JIS and SCOMIS open it will 
toggle between the two. 
Shift/F3 - will take you to the TPX Menu 
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To Change your Password without accessing the JIS-Link Mainframe 
 
Go to www.courts.wa.gov/jislink 

 
 

On the left under Current Subscribers – click option 8 Change Your Password. 

http://www.courts.wa.gov/jislink
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1. In the first box type your User ID 
2. Second box type your old password. Or read First Time Logon 1-5 to your right. 
3. Type a New Password – Follow the Password Standards (updated 12/12/2013) to 

your right. 
4. Type the New Password to Verify. 
5. Click Change Password. 



Revised August 20, 2018 30  

Accessing the JIS TPX Menu 
 
This screen is known as the TPX Menu. 

 

 
There are 3 different options that can be used to access either JIS or SCOMIS. They are as 
follows: 

 
1. At the Command ===> type the desired command (I.E. JIS, SCOMIS) and press 

<ENTER>. 
2. Place the cursor anywhere on the same line as the command you want to open and 

press <ENTER>. 
3. Press the Function key on your keyboard that corresponds to the Sesskey number 

listed (I.E. F1, F4). 
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JIS COMMANDS/SCREENS 
 

COMMAND TITLE WHEN TO USE COMMAND 
   
CDK Case Docket Inquiry To view a chronologic record of case activity 

for civil or non-civil cases in a district or 
municipal court. 

CIVI Civil Case Inquiry To view filing information for a civil case 
including all parties in a district or municipal 
court. 

CNCI Court Name/Case Index To view a list of civil cases for one or more 
persons in a specific district or municipal 
court. 

CVJI Judgment Disposition 
Inquiry 

To view all civil judgments for civil cases in a 
district or municipal court. 

DND Defendant Name Duplicate To view names, name codes, and defendant 
identifying data that are possible matches to 
search criteria entered in the Command 
Area. 

MAM Main Menu The JIS Main Menu (MAM) displays a list of 
public access commands. 

NCC Case Filing Inquiry To view filing information for non-civil cases 
in a district or municipal court. 

NMD Name Duplicate To view names and name codes of 
individuals that are possible matches to 
search criteria entered in the Command 
Area. 

PAR Case Participants Inquiry To view a list of participants in a civil or non- 
civil case. 

SNCI State Name Case Index To view a statewide list of non-civil cases 
associated with a Person record. Cases for 
any alias (AKA) names linked to a person do 
not display on SNCI. 

VIO Additional Violations 
Inquiry 

To view filing information for all violations in a 
non-civil case in a district or municipal court. 

QUIT To Quit (F4)JIS Type Quit in the upper left command field to 
quit (F4)JIS 
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Non-Civil Cases 
The following screens are available for viewing non-civil cases: 

 
 CDK Case Docket 
 NCC Case Filing Inquiry 
 PAR Case Participants 
 VIO Additional Violations 
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Statewide Search Using the Name: SNCI 
 
1. On the JIS Main Menu screen (MAM), type SNCI in the Command field (top left 

space  ) and press <TAB> until the cursor is positioned in the Name field. 
2. Type the name of the person using the format of LASTNAME, FIRSTNAME (note that 

there is a space after the comma and before the first name). If you include hyphens, 
apostrophes, and/or spaces in the name, you may also want to search again without 
those special characters.  If searching for a company, just type the name. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: If your screen looks like the above, the commands you have access to will be in 
white under Case Displays and Person Searching. Type the command in the upper left 
corner which is the Command Line. 
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3. Press <ENTER>  Result: The Name Duplicate Screen (NMD) displays: 
 

4. On the NMD screen, type X in-front of the desired name, press <ENTER> 
 

 
Note: If desired, press <F8> to display more names. 

 
Result:  The SNCI screen displays a list of cases associated with the selected name: 
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Note:  If asterisks appear under Status, case is archived.  You will need to contact 
the court where the case is filed to unarchive. If CL appears under case and no 
asterisks under status you may still be able to access the case.  Also, under CRT ID 
if it begins with S01 through S39 it is a Superior Court case. You will need to display 
the docket in SCOMIS. Either write down the case number(s) or screen print the 
page with the case number(s). If you need information on a court name from the 
three digit court id, please see the JIS/SCOMIS Codes Court IDs located at 
http://www.courts.wa.gov/jislink/public/codes/Shared/courts.htm for that information. 
You can also put the cursor on the three digit Crt ID and press F1 (help) to find the 
actual court name. 

 
Result of putting the cursor on SPD and pressing <F1>. 

http://www.courts.wa.gov/jislink/public/codes/Shared/courts.htm
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Press F3 to close the Help Screen. 
5. Use the <F8> and <F7> keys as needed to page forward and back through the cases. 

 
6. Tab to the case you need to display, type an X in the first position of the row at the (_). 

Press the Home key on your keyboard and it should take you to the top left command 
line.  Type CDK (to view the court docket entries) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Press <ENTER> Result: The Case Docket Inquiry screen (CDK). You will always come 
into the end of the docket.  Press <F7> to page back. 
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If you need to return to the SNCI screen with the list of cases associated with the selected 
name. Press the Home key on your keyboard, your cursor should be in the top left position. 
Type SNCI <ENTER>. Or, if you are done with this case and need to get back to the 
beginning of JIS to search another name, press the <Page Up> key on your keyboard. 

 
7. To perform a statewide search on another name, make sure the court is back to *SW, 

press <F3> to achieve that. Press <F2> to clear all fields then follow step 1 from 
above.  Or if you need to continue looking at more information on this person, 
continue with step 10. 

 
8. The NCC command: Displays Violation Date, Description, DV, Bail, Plea/Response- 

Finding/Judgment, Amount Due, Officer, Address. Type NCC at the command then 
tab to the case and type an X. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Press <ENTER>. 
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10. Result: 

11. To return to the case listing for this person, type SNCI in the command field <ENTER>. 
OR you can continue with this case. 
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12. The PAR Command (Participant Inquiry shows all parties involved). 
At the command line type PAR then tab to the case you need to view 
and mark it with an X <ENTER> 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13. Results 
 

Type SNCI at the command <ENTER> to return to the case listings for this person. 
OR you can continue with this case. 
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Additional Violation Inquiry (VIO). This screen provides the filing date, the original agency 
number, violation, description, DV, Plea/Response, and Findings/Jdgmnt 

 
At the command type VIO then TAB to the case and mark it with an X <ENTER> 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. Results 
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To Search with only the Case Number 
 
Note: You must know the court name where the case is filed in order to use this search. 
And you must know the 3 digit court ID associated with the court name. Please see the 
JIS/SCOMIS Codes Court IDs located at 
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&dir=clj_manual&file=courts 
for that information. 

 
1. On the JIS Main Menu (MAM) the top left space (  ) is your command line. 

Type CDK, tab to the Case number, type the complete case number then tab to Court 
and put the three digit court id <ENTER> 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Result: you will come into the end of the Case Docket Inquiry (CDK). 

http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&amp;dir=clj_manual&amp;file=courts
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3. Press <F7> (Page Back) until you reach the beginning of the docket. You can use 
the same commands as above to receive more information. 

 
Note: If you need a copy of the information provided on any of these screens you will 
need to use the Print Screen <PrtScn> key on your keyboard. If you need all the 
information in one document you will need to utilize Word or equivalent software and 
copy/paste the information to the document. 
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Civil Searches – this includes Small claims 
 
If the case is a Civil DV/Harassment related case – it will show up while searching SNCI. 
BUT if it’s a non-civil case without DV you will have to search with CNCI. 

 
You need to know what court the case is filed in. 

 
Commands Available for Civil Cases: CNCI, CDK, CIVI, CVJI, and PAR. 
The following commands are NOT used: NCC, VIO, DND, NMD, and SNCI. 

 
1. Type CNCI at the command line.  Tab to name and type the name (if it’s a person, put 

the last name, first name. There is a space after the comma and before the first name). 
Tab to NmCd and type CV. Tab to Court and type the court identifier 
(http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&dir=clj_manual&file=cour 
ts  ) <Enter>. 

http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&amp;dir=clj_manual&amp;file=courts
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&amp;dir=clj_manual&amp;file=courts
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&amp;dir=clj_manual&amp;file=courts
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<ENTER>. 

Result 
 

 
 
2. CVJI Judgment/Dispo Inquiry.  Tab to the case you need to view and type an X 
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Result 
 

 
 
3. Press <F3> on your keyboard to get the Judgment/Disposition Parties Inquiry. If there 

are no Judgments, it will tell you. 
 
4. Type CDK at the command line <ENTER>. 
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Result 
 

 
 
5. CIVI Civil Case Filing Inquiry <ENTER> 
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Result 
 

 
 

6. At any time you can type CNCI at the command line and it will take you back to the Civil 
Screen (CV) 
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Result: 
 

 
 

7. To go to the Main JIS menu (MAM), press the <Page Up> key on your keyboard. 
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8. To clear the information so you can type another name, press <F2> 
 

 
 
9. To set the Court back to statewide *SW, press <F3> 

 

10. To quit the (F4) JIS session, type QUIT at the upper left command field and press 
<ENTER>. 
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Superior Court Management Information System (SCOMIS) 
 
SCOMIS enables the superior court to record parties and legal instruments filed in superior 
court cases, to set cases on court calendars, and to enter case judgments and final 
dispositions. 

 
SCOMIS is a countywide case based system. Search for names and cases within SCOMIS 
on a county-by-county basis. If a SCOMIS case number is found in the JIS Application, view 
additional case details in SCOMIS by searching the appropriate court using the SCOMIS 
display commands. 

 
The following case types and screens are maintained in the SCOMIS application: 

 
CASE TYPES AVAILABLE IN SCOMIS  SCREENS AVAILABLE IN SCOMIS 

  
1 Criminal (unless sealed) Attorney Screen 
2 Civil Basic Screen 
3 Domestic Calendar Screen 
4 Probate Charge Screen (Case Types 1 & 8) 
5* Adoption Docket Screen 
6*  Mental Illness Names Screen 
7*  Juvenile Dependency Sentence Screen (Case Types 1 & 8) 
8 Juvenile Offender (unless sealed) Status Screen 
9 Judgment Summary Screen 
*Restricted case types (not 
available for Public viewing) 
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SCOMIS COMMANDS 
 
This is a list of the commands for use with the SCOMIS application. The following pages 
detail each command, section, and screen. It is only necessary to type the first four 
characters of the command and section. 
COMMAND? SECTION? CASE # ? WHEN TO USE COMMANDS 
This is the 
command 
column. 

Directs the 
computer to 
execute a special 
task. 

Some 
commands 
require a 
case number 

 

COUNTY Type County Name Leave Blank To view cases in a specific 
county. 

 
SEARCH Index Leave Blank To view the case index for all 

active and archived cases. 
 Attorney Leave Blank To view a list of attorneys 

currently recorded in the 
Supreme Court Person file. 

 
DISPLAY   To view specific case 

information. You may request 
one screen at a time. 

 Attorney Leave Blank You must know the bar # 
 Basic Enter Case# View Basic Case Information 
 Calendar Leave Blank Search for calendars by date 

and to display total settings or 
details/ 

 Charge Enter Case# View charges for case types 1 
and 8 only. 

 Docket Enter Case# View the case docket entries 
 Names Enter Case# Index of Litigants involved. 
 Sentence Enter Case# View Sentence for Case Type 1 

and 8 only 
 Status Enter Case# View the history of case 

management status 
 Summary Enter Case# View a summary of the case 

management and time-in- 
process status. 

 
FIND Judgments Enter Case# To view judgments filed on 

cases. You must know the 
originating case number. 

    
SIGNOFF Leave Blank Leave Blank To sign out of SCOMIS. 
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Accessing the SCOMIS Application 
Since accessing JIS-Link via the BlueZone software is the recommended option, this 
manual is written for BlueZone software access. 

 
Starting the SCOMIS Application 

TPX Menu: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. There are three options to access SCOMIS. 
a. Position the cursor anywhere on the SCOMIS line <ENTER>. 

 b. Press <F1> on your keyboard. 
c. Type at Command ===> SCOMIS <ENTER> 

 
Result: Your home court is the Superior Court in the county where your 
firm/business resides. If you are out of state your home court is usually King 
County Superior Court unless you have specified what court you would like for 
your home court. Note that it’s global within your company. 
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This above screen is called the SCOMIS Command Screen 

SCOMIS Command Screen Fields 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

There are 39 Superior Courts in the State Of Washington. 
To view the court id’s, see JIS/SCOMIS Codes Court IDs located at 
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&dir=clj_manual&file=courts. 

Command? You will type one of the four commands: COUNTY, SEARCH, 
DISPLAY, FIND, or SIGNOFF. Remember you only need to type the 
first four characters and you do not need to delete the last command. 

Section? Indicates the desired section of case information to display: 
ATTORNEY, BASIC, CALENDAR, CHARGE, DOCKET, NAMES, 
SENTENCE, STATUS, SUMMARY. You only need to type the first four 
characters and you do not need to delete the last request. 

Case 
Number 

A SCOMIS case number is formatted as follows: 93 1 00042 7. 
• The first two numbers represents the Case Filing Year. 
• The third number indicates the Case Type. 
• The next five characters are Sequential Numbers for the case 

type within the filing year. 
• The last number is the Check Digit to verify the correctness of all 

parts of the case number. If you receive a check digit error make 
sure you are in the correct County Superior Court for the case. 

A non-SCOMIS case number is formatted as follows: 1-1234567. 
• Case Type followed by a hyphen or dash. 
• Sequential Number. 

 

http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&amp;dir=clj_manual&amp;file=courts
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Keys to get around in SCOMIS using BlueZone only. See FAQ for a Keyboard layout. 
<F1> - Help Screen. Place your cursor on ‘certain’ words and press F1 and it will tell you the 

meaning. 
<F3> - will close the help screen 
<F7> - Page Back 
<F8> - Page Forward 
<F12> - Takes you back one screen at a time. 
<Page Up> (PA1) - Takes you back one screen at a time 
<Page Down> (PA2) - Key toggles between applications. If you have JIS and SCOMIS 
open, it will toggle between the two applications. 
<Shift> + <F3> - will take you to the TPX Menu. You will still be logged into SCOMIS 
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Sealed Cases 
 
Cases sealed by the court display on SEARCH INDEX but cannot be accessed with any 
display command. For a sealed case, the following information displays: litigant name, case 
number, and cause of action/charge. The case detail (connection codes and filing date) are 
replaced by the word SEALED. 

 
If that is all the information you need on this case you can press the Page Up key (PA1) 
until you are back to the SCOMIS Command Screen or if you need more information on this 
case you do not need to go back to the SCOMIS Command Screen to initiate the following 
display commands. You can do it from the sub command line and that is on the bottom left 
on the right side of the question mark (?). 

 
Change to another County 

 
Use the COUNTY command to choose the county in which the case is filed in. 
The example below shows that I’m in King Superior and I want to change to Snohomish 
Superior. 

 

 
• At COMMAND? type county. 
• At SECTION? type the county name you want to search (There are 39 counties). 

Note you only have to type the first 4 characters of the word. 
• Press <ENTER>. 

 
Result: 
The Database is set to the desired county, and the SCOMIS Command Screen re-displays. 
I went from King Superior to Snohomish Superior 
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If you have the person’s name but not the case number and you know which County Court 
the case is filed in you can perform a Search Index. 

 
SEARCH INDEX 
Use the Search Index command to search for active and archived cases in one county 
based on case type and name. Restricted case types 5, 6, and 7 and non-litigant names are 
not searchable. 

 
Note: The SEARCH INDEX Screen is NOT to be used to establish guilt or innocence. It 
should only be used to help identify case filing information. 

 
It is important to note that when the Search Index Screen displays results, the charge 
listed is the most serious offense filed in the ORIGINAL INFORMATION for a case. 
There may be an AMENDED INFORMATION filed; therefore, it is important not to rely 
on the limited data displayed on the SEARCH INDEX Screen. In order to find the 
results of the charges filed, it is the responsibility of the client to display the CHARGE 
and JUDGMENT Screens for charge and disposition detail. 

 
At Command? Type SEARch, tab to Section? Type INDEx <ENTER> 
**Note** There is no need to remove the last command. 
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Result: 
 

 
Follow the on-screen instructions to complete the CASE TYPE, NAME (Last, First), and 
Search Type (Weighted vs Unweighted, and Alpha). The YEAR(S) Filed field is optional 
<ENTER> 

 
 
Notes: 

• Weighted search is the default. 
• To use another search type U for Unweighted or A for Alpha List. 
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• For online help about the different search types, place the cursor on the search type 
field and press <F1>. Press <F3> to close the help screen. 

• For further information on Alpha, Weighted, and Unweighted searches, see the FAQ. 
• You can limit the search to a filing date range by typing the year (e.g., 2010) after 

year(s) filed or you can search by a date range (e.g., 2000 thru 2011). If left blank it 
will search the whole database. 

 
Result: 

 

 
Tab to the line of the name you want to view and press <ENTER>. Use the <F8> key to 
page forward and the <F7> key to page back. 

 
Note – cases marked with an asterisk * have been moved off-line, therefore you will not 
be able to view. 
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SEARCH ATTORNEY 
 
From the SCOMIS Command screen at the Command? Type Search and Section? Type 
attorney <ENTER> 

 

 
Result: 
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Type the Attorney’s last name, first name <ENTER> 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Result: 
 

 
Move your cursor to the attorney you want to display and press <ENTER>. 
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Result: 
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If you know the case number and the court the case is filed in, change to that County Court 
and use the Display Docket Command 

 
DISPLAY DOCKET 
At Command? Type Display then tab to Section? Type Docket <ENTER>. 

 
Result: The docket screen contains a record of papers filed, fees assessed and received, 
calendar dates, hearings held, and microfilm numbers. This screen will be found as part of 
all case types. If it’s a long docket, you will always come into the end of the docket. To get to 
the beginning press the <F8> key to page forward and press <F7> to page back. All 
SCOMIS Codes can be found at: http://www.courts.wa.gov/jislink/?fa=jislink.codes. 

 
To get back to the SCOMIS Display Screen press the <PAGE UP> <PA1>) on your 
keyboard. 

http://www.courts.wa.gov/jislink/?fa=jislink.codes
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DISPLAY DOCKET 
At Sub Command on the bottom left, after the question mark? Type display docket 
<ENTER> 

 

 
Result: The docket screen contains a record of papers filed, fees assessed and received, 
calendar dates, hearings held, and microfilm numbers. This screen will be found as part of 
all case types. 

 
 

If it’s a long docket, you will always come into the end of the docket. To get to the beginning 
press the <F8> key to page forward and press <F7> to page back 

Sub Command 
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DISPLAY CHARGE 
At Sub Command on the bottom left, after the question mark? Type display charge 
<ENTER> 

 

 
Result: The Charge Screen is used to record additional information in criminal cases. This 
screen will be found ONLY as part of Criminal and Juvenile Offender case types. 
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DISPLAY BASIC 
At Sub Command on the bottom left, after the question mark? Type display basic 
<ENTER> 

 

 
Result: The Basic screen contains the filing date, case title, cause of action, resolution, 
completion, and consolidation information. This screen will be found as part of case types 1 
through 8. 
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DISPLAY NAMES 
At Sub Command on the bottom left, after the question mark? Type display name 
<ENTER> 

 

 
Result: The Names screen provides an index of litigants involved in the case as well as their 
attorneys. This screen will be found as part of all case types. 
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DISPLAY SENTENCE 
At Sub Command on the bottom left, after the question mark? Type display sentence 
<ENTER> 

 

 
Result: The Sentence screen is used to record additional information in criminal 
cases. This screen will be found ONLY as part of Criminal and Juvenile Offender 
case types. 
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DISPLAY STATUS 
At Sub Command on the bottom left, after the question mark? Type display status 
<ENTER> 

 

 
Result: 

 

 
To display the summary from here you can press the <F11> key or go to the next step. 
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DISPLAY SUMMARY 
At Sub Command on the bottom left, after the question mark? Type display summary 
<ENTER> 

 

 
Result: 

 

 
All the above Display commands can be performed from the SCOMIS Command Screen. 
To get back to the first screen press the <Page Up> <PA1> key on your keyboard this will 
take you back one screen at a time. 
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DISPLAY ATTORNEY 
 
Use the Display Attorney command to search for attorney information using the Bar number. 
At Command? Type Display then tab to Section? Type ATTOrney <ENTER>. 

 

 
At Enter Bar Number type the attorney’s bar number <ENTER>. 
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Result: The attorney’s information will display. 
 

If you don’t know the attorney’s bar number you can Search Attorney 
 
DISPLAY CALENDAR 
You must be in the county you wish to view the calendar for. At Command? Type Display, 
at Section? type Calendar <ENTER> 
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Result: The Display Calendar command enables you to display the total number of cases 
set on a calendar (including subtotals for calendars made up of subsections) for a given 
date or date range. It also displays detail information about cases set on a calendar. 

 

 
a. Type the date of the calendar, using MM-DD-YY format. 
b. If you wish to select a date range, type the second date in the Through field. The range 

cannot exceed seven calendar days. If you select a range, response time will be 
somewhat slower since the search will require greater computer resources. 

c. Type either T or D beside the calendar of your choice. T will take you to the Display 
Calendar Totals screen. This screen provides a count of the number of cases set on the 
calendar on the date(s) you specified. D will take you to the Display Calendar Case 
Detail screen. This screen provides information about each case set on the calendar on 
the date(s) you specified. 

d. You can select multiple calendars for display, and the selection code can vary from 
calendar to calendar. Note: You cannot select multiple calendars if a date range was 
entered. You will receive an error message if you attempt to do so. If you do select 
multiple calendars, Press F5 on your keyboard to go from one calendar to the next. 



Revised August 20, 2018 75  

FIND JUDGMENT 
 
You must be in the county you wish to view the judgment for. At Command? Type FIND, at 
Section? type JUDGment <ENTER> 

 

 
The system will respond by displaying all Judgments associated with the specific case 
number. The list includes the Judgment number, type, title, date filed, and status of the 
Judgment. 
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To End the SCOMIS Application 
 
SIGNOFF: 
You can only issue this command from the SCOMIS Command Screen. At the Command? 
Type Signoff <ENTER> 

 

 
Result: Takes you to the TPX Menu 
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You can logout of JIS by typing at the Command F <ENTER>. 
 

 
Result: Takes you to the login screen. 

 

Click the  at the top right to close the session. 
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Probate Cases (Case Type 4) 
 
Log into SCOMIS 
You must know the county where the case was filed and change to that county. Once you 
are in the county at Command? Type Search, tab to Section? type Index <ENTER> 

 

 

 
At Case Type enter 4, at Name type the last name, first name <ENTER> 
Tab to the line of the case you want to view <ENTER> 
Decedent Name: Displays as a result of Search Index, on the Names screen, and Docket 
Screen 
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File Date: Displays on the Basic Screen and Summary Screen 
Case Number: Displays on Basic, Names, Docket, Summary 
Personal Representative: Displays on the Names screen if the clerk enters the Connection 
Code REPxx and the name of the Personal Representative once appointed.   It might be 
that the clerk has entered the name of the Petitioner, who may also be the Personal 
Representative, and another entry for the REP is not entered. 
Personal Representative Address: Usually not entered on the Names Screen. However, I 
have seen some courts enter this information for the PR. Just depends on the local clerk 
practice. 
Personal Representative Phone Number: Usually not entered on the Names Screen. 
Attorney Name: Displays on the Names Screen 
Attorney Address/Phone Number: From the Names Screen if you place the cursor on the 
attorney line then press F5, a new screen opens with the address and phone number for the 
attorney. 
Date of Death: This would appear on the Names Screen if the Clerk has entered it under 
the Deceased column. 
Date of Birth:  Not entered. 
Last Known address for decedent: Not usually entered 
. 
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ACORDS - Appellate Court Information System 
 

The Washington State Supreme Court and the three divisions of the Washington State 
Court of Appeals use the Appellate Court System (ACORDS) to record and track 
information about: 

 
• Cases involved in direct review 
• Cases appealed from Superior Courts 
• Cases appealed from Courts of Limited Jurisdiction 

 
ACORDS is a web-based application. You will need to have Internet Explorer 5.5 – 8.0 
installed.  ACORDS will not work with Google Chrome, Netscape, or Firefox. 

 
Logging on to the ACORDS Application 

 
You must establish a password or update an expired password before you can access 
ACORDS. There are two options to establish or change your password: From our web site 
www.courts.wa.gov/jislink under Current Subscribers click 8. Change your Password or log 
into the AOC mainframe to set up your password  (See  - JIS Link First Time Login). 

 

1. Open Web browser address http://www.courts.wa.gov/jislink. 
 

2. Select Option 2 – Access ACORDS. 
 

 
3. Type your User ID in the UserID field, and press <TAB> to position the cursor in 

the Password field. 

4.  Type your password in the Password field and press <ENTER>. 

http://www.courts.wa.gov/jislink
http://www.courts.wa.gov/jislink
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Searching ACORDS 
 

 

1. Designate a Court Name by clicking the  arrow in the Court Name field and 
clicking the name of the desired court. 

 
2. Click inside one of the blank fields and enter the other search criteria, and type the 

appropriate information: 
 

• Appellate Case Number – Use only digits; do not use dashes or spaces. 
• Participant Name – Use a name format of LASTNAME or LASTNAME, 

FIRSTNAME (e.g., Hamilton or Hamilton, John). 
• Appellate Case Title – Must match the short case title EXACTLY. 
• Attorney Name – Use a name format of LASTNAME, FIRSTNAME. 
• Trial Case Number – Do not use dashes or spaces. 

 
Exception: 
Pre-SCOMIS case numbers must include a dash after the initial digit. 

 
Note: 
Use only one search criterion in combination with a designated Court Name for each 
search. 
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3. Press <ENTER> or click <Submit>.  A list of search results displays. 
 

4. Click an Appellate Case # link to go to the Basic Case Information screen for that 
case. 

 

000000 Notice of Appeal 
Appellant V Respondent 123456 
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Navigating between ACORDS Screens 
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Printing from ACORDS 
 
Use the browser print function to print either an entire screen or a selected portion of a 
screen 

 
1. Choose one of the following options: 

a. Click outside a screen to choose the entire screen for printing. 
b. Select a portion of a screen for printing by positioning the cursor over the desired 

screen portion and click to select 
2. Choose one of the following options 

a. Choose the File menu and then the Print option. 

 
 

or 
 

b) Choose the print icon on the browser toolbar. 
 



Revised August 20, 2018 85  

Logging Off the ACORDS Application 
 
 1.  Do one of the following: 

• If you are on a case display screen (not the 
Search screen), choose the Logoff link from the 
navigation pane.  The Logon screen displays. 

• If you are on the Search screen, proceed to Step 
2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  Click the (close window) button in the upper 

right-hand corner of the browser 
 

 

. 
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e-Filing with Courts of Appeal  
 
If you are an attorney that finds the need to e-File with one of the three Courts of Appeal, you can 
learn how to use the Electronic Filing – Party Web Portal by clicking on the link below and scroll to 
Division III. Scroll down to eFiling Instructions for Division III. If you need to file with Division II, 
don’t worry these same instructions work for you as well. 
 
http://www.courts.wa.gov/appellate_trial_courts/ 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.courts.wa.gov/appellate_trial_courts/
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FAQS FOR JIS-LINK CUSTOMERS 
 
1. Can you do searches by attorney? 

No. You can only search by name or case number. However, you can find out who the 
attorney(s) may be on a case by using the PAR command once into a case. 

 
2. How do I get trained to use JIS-Link? 

 
The JIS-Link Manual gives easy-to-understand, step-by-step procedures for accessing 
the information you need and should be used as a self-training tool. No JIS-Link training 
is provided by the AOC. 

 
 

3. Can you do searches by offenses? 
No.  You can only search by name or case number. 

 
4. Why can’t I find the person I am looking for?  I put his/her name in. 

If you are searching on the person’s full name you may want to try last name, first name 
(Format = last name, first name). If you still cannot find the person you may want to try 
just last name, first initial (Format = last name, first Initial). If person business rules are 
not followed by the individual court, the person’s name could be entered into the system 
in various ways (Example:  Robert, Rob, Bob, etc.) 

 
It is also possible that they have used an alias name. You may need to look under a 
maiden name or a married name. 

 
5. Why can’t I log in?  The message I get is “The userid has been revoked.” 

If a customer has not used the system in the time frame of 6 months to 1 year the AOC 
security department will revoke the password and a site coordinator or AOC JIS-Link 
Administrator will have to reset the password. A customer would get this message also 
if they entered an incorrect password more than 5 times. 

 
6. Why can’t I log in? The message I get is “Invalid sign on Information entered. Try again 

or contact your JIS Security Administrator.” 
There are 3 possible reasons for this message. 

 
A. If the customer has not used the system in over 1 year AOC security department will 

delete the RACFID (User Id). A site coordinator will have to ask the AOC JIS Link 
Administrator to reinstate the User ID. If this happens to a Site Coordinator or 
Alternate Coordinator, they will need to see page 12 of the JIS-Link Security/Billing 
Manual. For Non-Coordinators the Site Coordinator will need to submit a Manage 
User ID Form. (See Page 6 of the JIS-Link Security/Billing Manual. 

 
B. A customer would get this message if the account has been suspended by the AOC 

JIS Link Administrator as well (I.E. Non-payment of account). For this action, a site 
coordinator would contact the AOC JIS-Link Billing Desk at 360-704-4018.   If you 
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receive a voice message, leave your name, phone number, name of your 
company/firm/ and your User ID. 

 
C. A customer has allowed Windows to save a password from any Web Site. Now, they 

cannot access JIS. They will need to clear the cache, which includes saved 
passwords.  Each Web Browser handles this differently so you may need to enlist 
your technical help for this. 

 
7. In SCOMIS when I type the DISPlay DOCKet with the case number, I receive a Check 

Digit error. 
 

You must be in the County database where the case is filed. Look at the top of your 
SCOMIS Screen towards the right, it will display which county you are currently in. If the 
case is filed in another county, change to that county and try again 

 
8. I cannot find Pierce County Superior Court cases in SCOMIS? 

 
Effective January 2, 2002, the amount of Pierce County Superior Court case information 
displayed in SCOMIS changed.  The SCOMIS docket record is abridged for active 
cases. The Pierce County Clerk maintains the automated official court record, including 
a complete docket in the Pierce County Legal Information Network Exchange (LINX). 
SCOMIS will continue to display complete Pierce County case status information as well 
as Name/Case and Judgment indices. JIS will continue to maintain and display, as 
appropriate, Pierce County statewide case, person, and order history information. LINX 
is available on the Internet at https://linxonline.co.pierce.wa.us/linxweb/Main.cfm. 

 

9. When did Court Data Go Online? 
 

Superior courts began using SCOMIS in 1977. 
Superior courts began using the JIS Application in addition to SCOMIS in 1994-1995. 
Superior courts update JIS person information and accounting data for criminal and 
juvenile offender case types. Superior courts also enter selected civil case information in 
JIS. Most superior court case data, however, is entered in SCOMIS. For specific court 
implementation dates for both Superior and District/Municipal, see: 
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&dir=clj_manual&file=court 
s 

 

10. I need information on SCOMIS Archived Cases. 
 

SCOMIS cases are eligible for off-line storage 18 months after case completion. An 
asterisk (*) displays next to a case number on SEARCH INDEX if some case data has 
been moved offline (archived). Electronic archiving moves attorney name, docket and 
case-flow management data from inactive completed cases to off-line storage. All other 
case information is still available. 

 
A SCOMIS archived case can only be restored by the Superior Court that entered 
the case. You may contact the courts directly for further information regarding archiving 
and retention of records. For court telephone numbers and addresses, see the Court 
Directory on the Washington Courts Web site at http://www.courts.wa.gov/court_dir/. 

https://linxonline.co.pierce.wa.us/linxweb/Main.cfm
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&amp;dir=clj_manual&amp;file=courts
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.codeview&amp;dir=clj_manual&amp;file=courts
http://www.courts.wa.gov/court_dir/
http://www.courts.wa.gov/court_dir/
http://www.courts.wa.gov/court_dir/
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2.Press Home after you press Esc 

Page Up Goes 
back one screen 
PA1 

F7 Page Forward F8 Page Back 

11. I don’t know what keys I’m to use to get around using BlueZone? 
 
 
 

1. to unlock the X Not Here 
bottom left of your screen 
press Esc then press the 
home key 

 
 
 
 

Pause/Break either clears out the sign on 
information or clears your screen. 
Depending on what screen you are on. 

 
 
 
 
 
 
 
 
 
 
 
 

  
 

12. Is SCOMIS/JIS access through JIS-Link like the SCOMIS/JIS public access terminals at 
the superior/district courts? 

 
The major difference is that, while public access terminals at the court provide access to 
that court's records only, JIS-Link provides you with access to all counties and court 
levels from the convenience of your office/home. 

 
13. Is there a monthly minimum charge for access to JIS-Link? 

 
Yes. The AOC will apply a minimum charge of $6.00 to all JIS-Link invoices. If 
transaction charges are less than $6.00, the subscriber will be billed $6.00; if 
transaction charges total $6.00 or more, actual charges will be billed with no additional 
charge. If a subscriber has no transaction charges for the month, and no invoice needs 
to be mailed, no charges will be billed. 

 
14. What about telephone charges? 

 
If you are accessing JIS-Link through your web browser, your ISP may charge you for 
connect time if the ISP's rate structure includes time based charges for connection to 
the Internet. 

 
15. Is there a time limit on how long we spend online with JIS-Link? 

 
You can use JIS-Link as long as you need during its scheduled hours of availability. 
However, if you are signed on but don't press a function key (i.e., <ENTER>) within a 
specified time (currently 10 minutes), it is assumed you are no longer actively using an 
application, and your session is terminated. 

Page Down 
Toggles between 
open Applications 
PA2 
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16. How many users can my firm have? Do more users cost extra? 
 

Your firm can set up as many JIS-Link users as you need. The AOC will assign a user 
ID for each person. There is no additional charge for more users at this time, but note 
that only the JIS-Link Site Coordinator you designate is authorized to contact the AOC 
JIS-Link Administrator via email for assistance. 

 

17. My organization has several offices--one in Seattle, one in Spokane, and one in 
Portland. Can we pay just one installation fee for all of them since we're all part of the 
same organization? 

 
When the same enterprise has multiple offices, multiple installation fees are generally 
required. As a guideline, an installation fee is required for each site which has a 
designated JIS-Link Site Coordinator. They are the only person authorized to contact 
the AOC JIS-Link Administrator via email for assistance or the AOC Billing Coordinator. 
If all setup and support activities for all sites are channeled through a single JIS-Link 
Site Coordinator, and the AOC only needs bill, one installation fee is sufficient. 
Installation fee decisions are made based on the amount of work required of the AOC, 
not the structure of the subscriber organization. 

 
18. Our law firm needs to bill the cost of using JIS-Link back to the clients. What is available 

to help with this? 
 

We suggest each person using JIS-Link keep a "call log" as they work. When you 
receive the monthly JIS-Link statement, each person will be able to indicate which calls 
are his/hers and the client to be charged. 

 
19. We're a state agency. How are billing arrangements handled? 

 
You will receive a monthly invoice. Pay by state warrant or journal voucher (JV), and 
return the invoice with a check or a copy of the JV. JV coding is shown on the invoice. 

 
20. When I encounter problems using JIS-Link, how do I get help? 

 
Problems encountered usually fall into these categories: 1) unable to get connected; 2) 
computer "locked up" while using JIS-Link; and 3) questions about how to use 
ACORDS, JIS, SCOMIS or other JIS-Link services. First, use all the resources at your 
disposal to solve the problem including the JIS-Link Customer Manual, JIS-Link 
Security/Billing Manual and your in-house experts. If the problem persists, your 
designated JIS-Link Site Coordinator may need to submit an eService Request 
explaining the problem. eService Center can be found at the JIS-Link page 
www.courts.wa.gov/jislink top right. 

 

21. How far back does SCOMIS data go? 
 

The earliest courts began entering data into SCOMIS in 1977 (Yakima County), and 
more recently, San Juan and Wahkiakum Counties began entering data in 1987. Our 
most recent addition is Garfield County in 1993. The vast majority of superior courts 
went on SCOMIS in 1984 or earlier. A table showing courts and their SCOMIS 
implementation date is available. 

http://www.courts.wa.gov/jislink
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.scomis&amp;dates
http://www.courts.wa.gov/jislink/index.cfm?fa=jislink.scomis&amp;dates
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To better manage court records, case detail information for old, inactive cases is 
frequently moved "off-line." Index information remains, however, to help locate a case. 
This frequently coincides with the archiving or microfilming of closed case records at the 
court. (Note: If you need a SCOMIS case un-archived, you need to call the specific 
court for assistance.) 

 
22. Is information on types of cases (unlawful detainers, judgments, etc.) available? 

 
If you have a name or a case number you can obtain information on specific cases. It is 
not possible to obtain a list of all cases of a certain type. 

 
23. I need the hard copy documents for a case.  How do I get them? 

 
To get hard copy documents for a case you will need to contact the court directly. AOC 
mainframe is incapable of storing documents like this. Some courts also have made it 
possible for you to download these scanned files from their web sites. To see if the 
desired court has this ability or to order the documents you will need to contact the court 
directly. You can obtain contact information on the Washington State Court Directory 
located at http://www.courts.wa.gov/court_dir/?fa=court_dir.county. 

 

24. When I am in JIS or PRINT or SCOMIS I get the following message, “DFNAC2001 
<current date> <current time> <session id> Transaction ‘OK’ is not recognized. Check 
that the transaction name is correct” or I get a bunch of random symbols or characters 
on the screen and cannot get off the screen. 

 
If your screen looks like either one of the above screens, press your <Pause/Break> key 
on your keyboard.  This will clear the screen.  Then, type LOGOFF and press <ENTER>. 

 
25. If after setting a new password you still cannot login because you are getting an invalid 

password error please follow the steps below. These steps work only for Internet 
Explorer. 

 
Make sure the following is not checked. 

Preserve Favorites website data 

Make sure the following are checked 
 

Temporary Internet files 
Cookies 
History 
Download History 
Passwords 
Click Delete 
After message shows at bottom of screen, Click Ok on AutoComplete Settings screen 
Click OK on Internet Options. 
Try to login to JIS-Link again. 

http://www.courts.wa.gov/court_dir/?fa=court_dir.county
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26. I need to install BlueZone on multiple PCs. Do I get charged each time I install this 
software? 

 
No. You can install BlueZone as often as you need to. You are only charged by 
transaction not per device. 

 
All JIS Production Application Schedule 

JIS Applications are listed below: 

ACORDS 
JIS (F4) 
JCS 
SCOMIS 

 
All JIS Production Applications are not available during the hours listed below: 

 

Monday – Friday 3:00 AM – 6:00 AM 
Holidays – 3:00 AM – 6:00 AM 

 
During Saturday and Sunday all JIS Applications are available 24 hours a day. 

 
All JIS Applications are also down the 2nd weekend of each month from 5:00 PM on 
Saturday to 6:00 AM on Monday Morning for System Maintenance. Current JIS System Info 
can also be found at www.courts.wa.gov/jislink. You will be able to see whether or not the 
JIS Systems are operating normally or if there is an issue. 
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